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Next Meeting:
Tuesday 13th March, commencing at 4.00 pm at
St Peter’s Hall, corner Draper and Hodgson
Streets, Ocean Grove.

Pat Hollis
Secretary & Membership.

Peter Oakley
Membership Assist, &
BMUG Assist.

Greg Melville
Meet & Greet, & Hall
&Equipment Co-ordinator.

This meeting will be devoted to “Back to Basics”, with both Halls being used.
Two Beginners Groups will receive Tuition and demonstrations in the back Hall. If you have a laptop or
iPad, bring it along. There will be ample opportunity to ask questions about any matter which is of
concern to you.
The more advanced members will meet in the main Hall with a Panel conducting a question and answer
session.

Jürgen Gross
BMUG Assist.

With assistance from:
Dick Brown

!The Bellarine Mac User Group is open to anyone who has an interest in Apple/Mac Computers, iPads, iPods,
iPhones or other Apple Devices.
Whether you are a first time user or a hot shot computer programmer, we would like to think that we have
something we can offer you, especially new Tips for each Device.
We are simply a group of people who get together once a month to exchange ideas, ask advice, share knowledge
and enjoy each other’s company.
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Don’t Miss Out.
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Membership 2012 - Reminder!
Our membership financial year commences in January and continues until
December each year.

Membership Subscriptions for 2012 are now overdue.
!
!
!

Single Membership !!
Couple Membership !
Remote Membership !

$50.00
$80.00 [per couple]
$25.00

!

Payment can be made:!
• At the March Meeting
• By mail to The Treasurer, 25 Catalina Cres., Clifton Springs, 3222
• Through Pay Pal via the BMUG Web Site.

!

PayPal is an easy and secure way to pay your subscription
Our new web-site is up and running with a Members Only section.
Financial Members will receive a User Name and a Password,
on payment of their 2012 Subscription, to access this Section.

This March meeting is the cut off date for
payment of 2012 Subscriptions. Members who
have not paid by this date will be removed from
the Membership Register.

Breaking news - Apple has announced a new
Operating System - OS X Mountain Lion

This next Operating System aims to knit together Apple’s Products and will copy more features and apps from the iPhone and iPad to the
Mac, when it arrives in our Winter (U.S.A. Summer), approximately a year after the release of the latest update, "Lion".
There will now be a suite of Mac apps that will mimic what’s on the iPhone or iPad, like Reminders, Notes, Messages and Game Center, as
well as Notification Center, Share Sheets, Twitter integration, and AirPlay Mirroring.
Mac users will be able to upgrade to Mountain Lion from the Mac App Store in our Winter of 2012. Through your free iCloud account, all of
these apps are synced instantly and smoothly across all your Apple devices. On the Mac, you type a reminder to yourself, and it will appear
simultaneously on your iPhone, iPad etc.
The new feature called AirPlay Mirroring will let users see on their Mac screen what is being shown on their iPhone, iPad or a television that is
connected to Apple TV.

For more information Google “Apple Mountain Lion” and you will find numerous Press reports, or go tohttp://www.apple.com/macosx/mountain-lion/
These excellent Video Tutorials are available to download from the App Store for less than $5.00 each!
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Have you experienced this problem with your iMac?
Recently I tried to access "System Preferences" on my iMac to no avail. When
clicking on the name in the Apple drop down menu it highlighted in blue but
nothing happened, the pane did not appear on any of the desktops.
My first step was to turn the computer off and disconnect the power cord, but
there was no change after restarting.
I then thought that it may be something to do with the connection between
System Preferences and the application I had just searched using "Spotlight". So, I
tried opening System Preferences from that application but had no luck.
Next I went to the Applications folder, found the System Preferences Icon and
tried opening from there and had a similar result.
The next move I considered was to reinstall the system that came with the
computer (Snow Leopard) and then upgrade to Lion. I was not game to make
this move without advice, in case something “went astray”.
The final alternative considered was to take the machine to New Wave Computer
Systems, but as I have difficulty lifting it into the box, then into the car, I decided
to seek advice from various Apple/Mac forums.
There were several options offered to me and the first one I tried worked!

Member Benefit
Bulk Book Purchase
Fifteen copies of the book “Mac
Computing for Seniors in easy steps”
have arrived. There are still six available
for purchase at $15.00 per book.

!

Solution:
!

I was told to Zap the PRAM.
To do this you restart the computer and immediately hold down
the following 4 keys until you hear at least 2 opening boings. The
keys you hold down are “Command”>”Option”>”P”>”R”.
After the second or third boing I released the keys and the
computer started normally - problem solved!
Note: After taking this action it may be necessary to readjust the
brightness and sound levels as these will have reset to default.

Article by Member James Strachan

A Gift Certificate for the “disclabel”
Software, generously provided by Smile
Software, will be presented to one lucky
member as a free door prize at this
meeting.
See last month’s newsletter for a review
of the software.
4

Editorial
Welcome to this March edition of the Newsletter.
I have received feedback from some Members who feel that the Newsletter, whilst full of interesting content, contains too many pages.
In future, I will endeavour to try and keep the size of the Newsletter to approximately 14 pages and I will spread the articles out to make
them easier to read. Please continue with your feedback on any matters relating to the Newsletter.
Most of the Mac Tips and Tricks in this Newsletter refer to OS X Lion.
If information specifically relates to OS X Snow Leopard (i.e. OS X prior OS X Lion), then it will be clearly stated.
For the new members joining each month, who may be recent converts to Apple products, and who may in some cases be using older
computers with Operating Systems that do not have the most recent OS X Lion Operating System, I do endeavour to cater for your
requirements by ensuring, where possible, that articles cover the various possibilities. However, it is becoming increasingly difficult to
achieve this as changes to Software and Hardware are now quite frequent. I find that once I have adapted to new ways of doing things, it is
difficult to remember how I used to do it with previous Software or Hardware.
Your Committee is still urgently seeking at least one additional member to join us. If the Club is to continue providing interesting Programs
which aim to cater for all levels of expertise within our membership, then we do need these extra Committee members in order to share the
workload.
Please give this matter your earnest consideration, and speak to any Committee member if you need more information or if you feel that you
have something you could offer.
This month will see one lucky member receive as a door prize, a lovely printed Gift Certificate for the disclabel software.

We still have six copies of the book “Mac Computing for Seniors in easy steps”. They will be available for purchase at
the front desk, for $15.00 each.

!
!

!
!

!
!

!
!

!
!

!
!

!
!

!
!

!

Peter Baldwin

Email Peter....
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Using Lion Recovery to Solve OS X Lion Server Installation Problems
If you suspect a disk error is causing problems during installation, you can use Disk Utility while booted into the Lion Recovery
volume named Recovery HD, a volume that is hidden from view in tools such as Disk Utility. To boot into Lion Recovery, reboot
(or turn on) your Mac; then, after you hear the startup chime, hold down the Command key and the R key, and keep holding
Command-R until the Apple icon appears. Alternatively, you could hold down the Option key after a reboot and manually select
Recovery HD from the Startup Manager list of available volumes. Lion Recovery displays a Mac OS X menu bar and a Mac OS
X Utilities window.
Note: If you see a login window or your own desktop and icons, it is possible that either your Mac does not have a Recovery
HD volume, or that you didn't hold Command-R early enough, so restart and try again.
Open the Disk Utility after you boot into Lion Recovery. You can use the Disk Utility's First Aid tab to run the Repair Disk and
Repair Disk Permissions; or, if you want to try a fresh installation of Lion and then install Lion Server, you can use the Erase
tab to erase your entire disk or volume.
To monitor the Recovery HD logs, you can choose Window > Installer Log; then, from the Detail Level pop-up menu, choose
Show Errors Only, Show Errors and Progress, or Show All Logs.
For more information about Lion Recovery, including Lion Internet Recovery, see the Apple Support Document HT4718, "OS X
Lion: About Lion Recovery."
Excerpted from: Apple Pro Training Series: OS X Lion Server Essentials: Using and Supporting OS X Lion Server by Arek Dreyer and Ben Greisler

Filter Your Incoming Mail with Rules
You can create rules (filters) to do things like sort incoming mail into an appropriate mailbox, highlight certain messages in a particular colour,
automatically forward to a different address, delete a message before it even appears in your box, send an auto-reply, and more. (Note: All filters
apply to all email accounts unless you specifically choose an account in the Rule itself. If you plan to sort mail into different mailboxes, first create
the mailboxes you want so you can organise with them.)
1.
2.
3.

4.
5.

From the Mail menu, choose Preferences.
Click the Rules icon and then click Add Rule.
Choose your parameters for the type of mail coming in and what to do with it. (If you forgot to make a special mailbox for something, you
can actually do it while the Rules pane is open on your screen: Choose Mailbox > New Mailbox. The new mailbox immediately appears in
the pop-up menu.)
In the Rules dialog, add conditions and choose as many actions as you require.
Click OK when you're done.

Your new rules begin applying immediately for any incoming email.
Excerpted from Mac OS X Lion: Peachpit Learning Series by Robin Williams and John Tollett
6

How to Share Files and Documents with Mac’s iChat Theater
You can share pictures from iPhoto, presentations from Keynote, and even QuickTime movies by
turning on your Mac’s iChat Theater. You can take advantage of iChat Theater in a few ways,
provided your broadband Internet connection is up to the task
•

To share pictures from iPhoto, from the File menu, choose Share iPhoto with iChat Theater
and select the pictures you want to show off. You can even present an album as a slide
show, provided you have at least iPhoto ’08.

•

To share files that aren’t pictures in iPhoto, from the File menu, choose Share a File with
iChat Theater and then select the files you want to share. If you’ve already begun your
video chat, you can merely drag the item into the video window. You’ll be asked whether
you want to share the file through iChat Theater or send it as a file transfer.

If you’re not sure whether you can share one of your files in iChat Theater, highlight the item in Finder and choose Quick Look from the File
menu. If you can see the file, so will the person you want to show it to through iChat Theater.
Once you have a video chat running with someone, click the Plus symbol at the bottom of the window and select the option to share a file
through iChat Theater (or simply drag the file to the video chat window). The image of the person you are video chatting with drops down into
the corner and the image or file you are presenting takes over the main part of the screen. This is great for reviewing images or paging through a
Keynote presentation. There are rumours that the next version of OS X Lion will support sharing web pages.
iChat Theater also works when doing multi-person chat; as a presenter your multi-chat window is taken over by whatever it is you are sharing,
as you can see below:
Important Tips:
When you have a single or multi-user video chat running you will see a Mute button in the lower
portion of the screen. Clicking that will mute your audio, but not the audio on the other end. As a result,
if you click Mute your chat partner will continue to be both seen and heard and your video will
continue without sound. If the other person mutes the sound, don't say anything stupid like "wow,
when is this going to be over?".
Holding down the Option key transforms the Mute button into a Pause button. This both mutes the
audio from your end as well as freezes the video from your end. Like Mute only, this only applies to
your feed; the other end is still visible and audible.
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Favourite Mac Gems of 2011
The following links give you Macworld’s favourite products
for 2011-

Producer: Discovery Channel, Adam Savage, Jamie Hyneman
Description:
In 'iGenius: How Steve jobs changed the world', Adam Savage and Jamie
Hyneman (known from MythBusters) honour Steve Jobs the man who changed
the way we see technology today.
The documentary features an overview of the life of Jobs, from the foundation of
Apple to the legacy he left us after he died in September 2011.
It starts off with the start of Apple and Steve’s first inventions.
When the first Mac didn't turn out to be popular with the public, Steve came
into problems with the management of Apple and was dismissed. In the years
after, he played an important role at Pixar.
The documentary video gives an extensive overview of the way Jobs saw
possibilities everywhere he worked in making technology for the people.
Through several interviews and a lot of different images about the products Jobs
worked on, such as the introduction of the iPod, iTunes, the iPhone and iPad.
Though the documentary is a tribute to Jobs work and life, it almost feels at
moments like an advertisement for Apple products.
Overall it is a nice view on Steve Jobs life and how he changed the world of
technology.

“We’ve given you our annual Eddy Awards for the best overall
products of the year and our App Gems Awards for the best iOS
apps. Which leaves us with the best Mac Gems of the year.”
http://www.macworld.com/article/164553/2011/12/
favorite_mac_gems_of_2011.html#lsrc.nl_mwgems_h_crawl

Video Tutorial for members still using Snow Leopard
The Video Tutorial “Tutor for Snow Leopard”,available from the
App Store for $2.99 may help you with some of your queries/
problems.
It is an excellent starter for Mac beginners and
Intermediate users, who are still using Snow
Leopard. Last updated 11th July 2011.

http://watchdocumentary.com/watch/igenius-how-steve-jobs-changed-theworld-video_9329fe70a.html
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Product Reviews
Clarify for Mac
http://www.bluemangolearning.com/
View the online help

Available from the Apps Store

http://www.boxwave.com/products/capacitivestyra/apple-ipadcapacitive-styra_3779.htm

Software Details
1
2
3
4
5
6

BoxWave is a company that makes accessories for mobile devices including
selling several different iPad stylus and pen combinations-

Universal Meritus Capacitive Styra ($22.95):

Pen and Stylus in one
On one end of the Styra is a rubber tip and on the other end is a
removable cap which covers a retractable black ballpoint pen.This
dual functionality provides a great
deal of benefit in the work setting.
The pen provides a smooth writing
experience. On the downside, when
removed, the pen cap does not fit on
the back of the pen because the stylus
tip gets in the way, making the pen cap easier
to lose. Also, ink refills must be ordered from
Boxwave.! !
The current state of available styluses for the iPad are not ideal. While ZoomMode in many notepad applications offers a functional work-around for the
lack of sensitivity to fine-tip styluses, this is still an area where future tablet
devices can improve.
!

!

!

!

!

!

Reviews by Peter Baldwin

Company: Blue Mango Learning
Current version: 1.0.2
Download size: 7.2 MB
Release date: 09.12.11
Requirements: Mac OS X 10.6.6 or later
Current price: $29.99

Features:
• You can capture screenshots, or multiple images to create more
effective and clear communications, import graphics or add photos.
• Clarify has everything you need to communicate visually. Built in
annotation tools include…
Arrows to point to exactly what you’re describing
◦
Rectangles and ovals help you call out certain areas for
◦
easy visuals and more clear communication
Highlighting lets you highlight text and interface
◦
elements
Our sequence tool allows you to quickly number areas
◦
of your screenshot with a single click of a mouse.
◦
Text annotations help you easily describe the image and
clarify the use of any other tools you use!
◦
The blur tool lets you blur out sensitive and irrelevant

information
• Share your new communication online at Clarify-it.com (our free
image sharing service) or email.

For more details on these Products click the links listed above.

9

Four tips for securing your iPad and everything on it
Don’t make the mistake of assuming that just because your iPad isn’t a typical computer, it isn’t a security risk. The iPad is
very much a computer. It stores both your private and business information. It stores your email messages, server
information, passwords, contact lists, browser history, cookies, and so on.
The information saved on your iPad is a complete copy of your digital data and it’s a gateway to any system it accesses
information from, including your email and corporate network. As such, it’s a risk and it’s vulnerable and it needs to be
protected.

Here are some steps you can take to properly protect the data on your iPad
1. Implement a Passcode Lock:
This is the most common technique and provides a basic level of security. Go to Settings -> General -> Passcode
Lock to create a four digit code that will be required to turn on and wake up the device. You can set the idle
time interval (the shorter, the more secure). The option to wipe the device if an incorrect code is entered 10
times should also be set. This will prevent someone from trying to guess your passcode with brute force.

!

!

2. Turn on Find My iPad:

What happens when you leave your brand new iPad in a taxi or at a restaurant? As long as you’ve activated
the “Find My iPad” feature of Apple’s MobileMe or iCloud service, you’ll be okay. Simply sign on to your
MobileMe/iCloud account and from there you can remotely lock the iPad (which shouldn’t be necessary if you
followed step 1), have it play a sound (in case it’s somewhere nearby and not actually lost) and change the
screen to a message of your choice (“Please call my owner at 03 5243 5555ʺ″). And in case it doesn’t find it’s way
home, you can remotely wipe all the data.

Note: In Last month’s newsletter I described how to set up your MobileMe/iCloud Account.
3. Sync Often by connecting to iTunes on your computer:
This isn’t so much security as it is a best usage practice. Every time you sync your iPad, it is backed up to your computer. If it is ever
lost or you have to wipe all the settings and data, you will be able to restore everything you erased. Also, Apple regularly updates its
operating software on all devices to keep up with the latest vulnerabilities and you automatically receive these updates when you
sync.
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4. Use only secure wireless connections:
This applies not only to the iPad but to to any device, including your laptop, which uses a wireless connection. The Wi-Fi
network at the local Starbucks or McDonalds is not secure. It’s all too easy with inexpensive software and some basic
knowledge to have your data compromised. When connecting via a non-secured Wi-Fi network, be sure to use a VPN
connection to ensure your data is secure and encrypted. If you don’t have access to a corporate VPN, there are public
services available.

At our last meeting Matt Vistarini, Manager of the Geelong New Wave
Computer shop, delivered an excellent presentation and demonstration on how
to Sync various Apple devices, making use of the iCloud service provided by
Apple. He also spoke on the types of things you can do with an Apple TV.
Judging by the number of questions, the areas covered by Matt were of
considerable interest to members, as we ran out of time.
We do appreciate the fact that Matt makes his services available to our Group
on our request.
Your Committee will give more consideration to these topics and endeavour to
conduct some future workshops (broken into Groups according to your
experience) in order to allow you to get some “Hands on” experience.
Please advise us of any particular problems you may be experiencing or what
areas you would like to see further explained.
Below, are two summary tables and a list of Links relating to “Transitions for MobileMe Services to iCloud” and also
“Transitions from previous Operating Systems to OS X Lion”.
Some of the information may now be slightly irrelevant as it is a few months since it was prepared.
The February Newsletter also contained information and links relating to syncing and iCloud.

!

!

!

!

!

!

!

!

!

!

!

!

!

Peter Baldwin
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Resource sites:
Mac OS X Lion Application Compatibility:
http://www.macworksinc.com/repairs/tag/lion/
Gizmodo instructions:
http://gizmodo.com/5808238/what-we-know-about-lion-and-why-it-may-be-the-lastmac-os-x
MobileMe to iCloud Transition FAQs:
http://www.apple.com/mobileme/transition.html
How to Move an iWeb site from MobileMe to Another Web Hosting Service:
http://support.apple.com/kb/HT4686
How to Save Your MobileMe Galleries and Photos:
http://support.apple.com/kb/HT4702
Lion compatibility chart:
http://roaringapps.com/apps:table/tags/_s/index_tags/ Apple’s MobileMe
Transitions FAQ:
http://www.apple.com/mobileme/transition.html The Lion Vet: The Problems and
The Solutions:
http://macatlehighvalley.org/indexLV.html
Jim Dalrymple's iWeb to WordPress converter:
http://www.loopinsight.com/2011/09/14/iweb-to-wordpress-converter/
Ryan Fass’ Replacing the MobileMe Features Lost in iCloud:
http://www.peachpit.com/articles/article.aspx?
p=1751378&WT.mc_id=PP_NL_WhatsNew_2011_10_13
12

BMUG Assist Program
This Program is available to all members. We will attempt to
resolve your urgent Mac problems if we can, or give you
advice about who can.
In many cases you may find a solution to your problem by
inserting your question in Google. It is amazing what
information you will find.
Jürgen Gross is available to take your call on 5255 4517.
In Jürgen’s absence, Peter Oakley is available on 0409 094 655.
Committee Members (Pink Tags) are available during the
coffee break for assistance.
Alternatively you could make a booking for assistance by
Make a Booking
with Peter Oakley... using the Form on the website or by contacting Peter Oakley
using the email link listed opposite.

BMUG manuals are now available on the Website for Members to
download for free.
You will need to obtain your member password from the Membership
Secretary before you can access the Member Section. Remember that the
manuals are no longer updated, but still contain a lot of useful
information.

New Members Welcome
We welcome all Apple/Mac Users.
What are you waiting for?
Web: www.bellarinemac.org.au
Email: Email Pat ...

Member Competition
A Prize Certificate containing a free
license for PDFpen.

This excellent Software, valued at $64.99
has generously been provided by Smile
Software.
Unfortunately no entries were received
for this competition, and therefore it will be held over
for another month.
If you would like to take part in this competition,
there is still time. See competition details in last
month’s newsletter.

Email Editor Peter....
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Get to know the members of your BMUG Committee...

Email David

David Dixon,
President,
Hall Liaison.

Peter Baldwin,
Vice-President,
Newsletter Editor,
Library Co-ordinator &
Buyer.

Jürgen Gross
BMUG Assist

Greg Melville
Meetings Manager,
Hall & equipment
Co-ordinator.

Ian Little
Treasurer.

Peter Oakley
Membership Assist
BMUG Assist

Pat Hollis
Secretary,
Membership.

Prue Paterson
Web Manager
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